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Matrix maker 2.5 (fat)

TWELVE-TONE MATRIX APPLICATION

ReadMe  FILE for using Matrix maker 2.5 (fat) with Microsoft Word 5.1

The Matrix maker 2.5 folder contains the latest (January, 1996) version of Matrix maker.  This
program is a "fat" binary application, containing both 68K and native PowerPC code.

The folder containing this text file includes several items:

1) the Macintosh Matrix maker 2.5 (fat) application, a fat binary application containing 
both  68K and PowerPC native code;

2) a SimpleText ReadMe file;
3) a folder labeled "for MSW 5.1 users" (the folder containing the file that you are now

reading);
4) a folder labeled "for MSW 6 users";
5) the Matrix maker script AppleScript application (usable only with MSW 6.x)
6) a sample output file labeled ‘sample “matrix.txt”’;
7) a sample output file labeled ‘sample “header.txt”’;
8) a sample of the “finished product”, labeled “sample matrix output”.

If you are equipped with Microsoft Word 6.x, you should stop here and open the folder "for
MSW 6 users", read the enclosed documentation, test the operation of the AppleScript "Matrix
formatter" application, and then (if everything works properly) drag this folder and its contents
to the trash.

If you have reached this line, then I assume that either your MSW version is 5.1 rather than 6.x
or you have not been able to use the AppleScript application "Matrix formatter" with your Word
6.x installation. This folder ("for MSW 5.1 users") contains five items:

1) this ReadMe file
2–5) four  Stationery  files  in  Microsoft  Word  (5.1a)  for  converting  the  output  of  the

Matrix maker 2.5 (fat) application into easily readable form as 12 by 12, 7 by 7, 6 by
6, and 5 by  5 matrices. 

This application was originally designed (v 1.0) to facilitate the necessary but often somewhat
laborious "busy-work" of constructing 12 by 12 matrices used in the composition (or analysis) of
twelve-tone musical compositions. The application was subsequently (v 1.1) augmented to allow
the creation of matrices of other dimensions than twelve, particularly those involving five, six,
and seven elements. From its inception, the software package has also allowed the use of the M5
and M7 transforms and rotation as optional operations. The stationery files included for matrices
of  five,  six,  seven,  and twelve  elements  allow the  easy creation  of  matrices,  either  with  or
without  pitch-class  names,  within  the  standard  grid  format.  An additional  option  allows  the
selection  of  any  pitch-class  name  as  "0"  (zero).  Matrix  maker  1.2.1 added  "hidden  text"
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instructions for pasting the created data onto each of the (MS Word only) stationery files. Matrix
maker 2.0 (fat) eliminated some remaining error-detection bugs, provided a more user-friendly
interface, and added the option (for MSW 6.x users) of automating the formatting process by
using  an  AppleScript  application,  while  still  allowing  the  formatting  to  be  accomplished
manually, as before, for those who either do not have MSW 6.x or whose MSW 6.x applications
stubbornly refuse to work with the script provided (an option dictated by the always prudent
application, whenever computers are involved, of Murphy's Law). The additions that distinguish
Matrix maker 2.5 (fat) are explained in the MSW 6.x ReadMe file in the folder “for MSW 6
users”; users of MSW 5.1 are not affected by these changes.

Creating an output file

To use the Matrix maker 2.5 (fat) application with Microsoft Word 5.1, perform the following 
steps to create a 12 by 12 matrix: 

1) Double-click on the Matrix maker 2.5 (fat) icon.

2)  The console window will appear, and you will be issued several prompts. In each case,
after  entering  the  information  requested,  press  <ENTER>.  You  may  exit  from  the
application at any time by typing "<COMMAND>–Q".

                      
a) You will be prompted to enter the name of the piece for which the matrix will be used.

b) You will next be prompted for the set on which you want the matrix to be based.
(These instructions apply to the creation of a 12 by 12 matrix, but they may be used
with some modifications for other matrices as well—see below.) This set MUST be
entered as a series of one-digit numbers from 0 to 11, all but the last followed by a
comma.  The numbers "10" and "11" must be represented by the characters "t" and
"e", respectively (whether these characters are in upper or lower case is irrelevant;
this is also the case with all other alphabetic characters entered when this application
is used).  Typing errors will be flagged, including the entry of duplicate pitch-class
numbers and the typing of more that twelve entries, and an opportunity for re-entry of
the set will be provided. The set entered need not begin on "0" (zero); a set entered as
beginning on any other number will automatically be transposed so that the first note
becomes zero. You will be asked if the number of elements in the array is correct. As
in all such prompts, type "y" (yes) or "n" (no).

c) You will be asked whether or not you wish the set entered to be subjected to an M5 or
M7 transform.  Enter "y"  or "n", as above. If you entered "n", the program will
proceed to d) below.  If you entered "y", you will be prompted for the number of the
transform, in which case you should enter either 5 or 7. (If you are not familiar with
this relatively recent twelve-tone transformation, enter "n".)

d) You will be asked whether or not you want rotation.  If you entered "n", the program
will proceed to e) below.  If you entered "y", you will be asked for the number of the
note within the hexachord or set on which the rotation will begin (the numbers range
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from 2 through 6, in the case of hexachords). Obviously, you could enter "1", but this
would result in no rotation at all.

e) You will be asked whether or not you wish pitch-class names to appear below the
numbers.  If you enter "n", the window will display the message "The matrix has
been successfully created! The matrix output files have been saved in the folder
in  which  this  application  is  located."  (2  spaces)  "To exit,  type  <Return>."  (2
spaces)  "If  you  are  using  Microsoft  Word  6.x  with  the  AppleScript  “Matrix
maker script” automated formatting application, the matrix will be formatted
without further user intervention. (space) If you are not taking advantage of the
full  automation  capabilities  of  this  package  but  are  using  the  AppleScript
“Matrix formatter” application, then double-click on the "Matrix formatter"
icon  within  the  folder “for  MSW 6  users”  to  format  and  save  your matrix.
(space) Otherwise, format and save it manually according to the instructions in
the appropriate "ReadMe" document."

If you enter "y",  you will be prompted to enter the pitch-class name (either single
letters from A through G (case irrelevant) or two-character names consisting of one of
these letters followed by "#" (no flats, please--there is no flat character in the font!).
After you enter this item, the message mentioned earlier in this paragraph will appear.
In either case, do not follow the instruction to double-click on the "Matrix formatter"
script, which  works only with MSW 6.x. Instead, proceed to the instructions below.

Processing the output file

When  you  have  exited  the  application,  you  will  notice  that  the  output  files  "matrix.txt",
"header.txt",  and "mtrxsize.txt"   will  reside  within the same folder  that  contains  the  Matrix
maker  2.5  (fat) application.  (For  the  purposes  of  this  procedure,  you  should  drag  the  file
"mtrxsize.txt" to the trash, since it is not used without the MSW 6.x AppleScript application.) 

With the default font set to "Times" (12 pts.)—this is not an absolute necessity, but the script is
designed  with  that  font  and  type  size  in  mind—,  open  "matrix.txt"  in  Microsoft  Word  5.1,
highlight the matrix with the "Select All" command from the "Edit" menu (or use the keyboard
shortcut "<Command>–A"), and from the "Insert" menu select "Text to Table".  (If you selected
the option of displaying the set data in the matrix without pitch-class letter-names, there will be a
line consisting entirely of commas above the first line of the output data  and there will always be
such a  line  below the  last  line of  numbers;  be  sure that  any such line  is  included in those
highlighted.)  When  the  dialogue  box  appears,  "comma  delimited"  will  in  all  likelihood  be
checked; if not, check it now. 

When the text-to-table conversion is complete, copy the table (if it is not already highlighted,
highlight it with "Select All" or "<Command>–A", as above) with the "<Command>–C" copying
command (or choose "Copy" from the "Edit" menu).  

Next, open the appropriate matrix stationery file (the files supplied are suitable for 5 by 5, 6 by 6,
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7 by 7, and 12 by 12 matrices), highlight the grid by double-clicking anywhere within it while
holding down the <Option> key, and press "<Command>–V" (or select "Paste" from the "Edit"
menu) to paste the clipboard contents  onto the matrix.  

In case you forget the procedure to be used, you may refer to the "hidden text" that appears
above the grid; this text, and the sectional divisions marked by the dotted lines, will not normally
appear when the final document is printed. (You may find it necessary to nudge the number in
the upper left-hand corner one space to the right to line it up with the others.) 

Next, open and copy, as above, the contents of the file "header.txt" and paste the line(s) at the top
of the matrix grid document, centering the line(s) and making font changes if desired. 

All that remains is to name and save the file in the usual fashion, as a "Normal" file. Be sure not
to  save  it  with  the  name of  any of  the  existing  stationery  files,  and do not  save it  as  type
"Stationery"!  If you do, you will destroy the existing stationery template!  

Testing the “Matrix maker 2.5 (fat)” application

To test the application after installing it, enter the following information  at the prompts. (In this
list  each  prompt  line  is  preceded  by "<"  and  followed  by  ">"  for  your  convenience;  these
symbols do not appear in the prompts on the screen.  You should enter in turn all  items not
preceded by "<" and followed by ">".):

<Enter the title of the piece.>
My Incomparable Masterpiece
<Enter the set in one-digit integers, separated by commas;> 
<for pc numbers 10 and 11, use "t" and "e" respectively.>
3,t,7,6,e,2,9,0,5,4,1,8
<You have asked for a 12 by 12 matrix. Is this correct? Enter y> 
<or n.>
y
<Do you want an M5 or M7 transform?  Enter y  or n.>
y
<Enter the M-transform number.>
7
<Do you want set-rotation? Enter y or n.>
y
<Your set is a full twelve-tone set. Do you want intra-hexachordal>
<rotation? [This type of rotation will preserve the properties of the>
<source hexachord.] If so, enter y.>
<If not, enter n, in which case the rotation>
<will be applied to the set as a whole.>
y
<Enter 2 for 2nd note, 3 for 3rd note, etc. for the desired rotation.>
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3
<Do you want pitch-class names to appear under the pc>  
<numbers in your matrix? Enter y or n.>
y
<Enter pitch-class name to be used as pitch-class 0 as>
<letter-name--sharps only.>
f#
< (space)>
< (space)>
<The matrix has been successfully created!>
<The matrix output files have been saved in the folder in which this application>
<is located.>
< (space)>
<To exit, type <Return>.>
< (space)>
<If you are using Microsoft Word 6.x with the AppleScript “Matrix maker script”>
<automated formatting application, the matrix will be formatted without further>
<user intervention.>
< (space)>
<If you are not taking advantage of the full automation capabilities of this>
< package but are using the AppleScript “Matrix formatter” application, then>
<double-click on the "Matrix formatter" icon within the folder “for MSW 6 users”>
<to format and save your matrix.>
< (space)>
<Otherwise, format and save it manually according to the instructions in the>
<appropriate "ReadMe" document.>

The output file "matrix.txt", should be identical to the sample file ‘sample “matrix.txt”’ provided
for  comparison;  likewise,  the  output  file  "header.txt"  should  match  the  sample  file  ‘sample
“header.txt”’. The sample input data listing and output files are designed to create a 12 by 12
matrix, but other matrices can be created in the same way by following the instructions on the
screen. If at  any time you should wish to abort  the program, simply type "<COMMAND>–
<period>", followed by "Quit" from the file menu (or simply use the shortcut "<Command>–
Q"). Remember that the file "mtrxsize.txt" is useless for the purpose being described here and
should thus be trashed. You should also trash "matrix.txt" and "header.txt" after formatting your
matrix in order to avoid future file-name conflicts, should you create more matrices.

Differences between v 2.5 and v 2.0

As explained earlier, there are no differences between these two versions that affect users of
Microsoft Word 5.1.

Differences between v 2.0 and v 1.2.1



6

The differences between v 2.0 and earlier versions are significant. Some remaining bugs have
been ironed out, and a much more user-friendly interface has been added. The principal change,
however, has been the addition of an AppleScript application that can automatically copy, format,
and save a completed matrix with almost no user intervention, provided that the user has an
active  installation  of  Microsoft  Word  6.x  on  his/her  system.  Since  the  use  of  the  script
application may not work in all cases, however, the option of formatting the matrix manually, as
in earlier versions, has been retained. Folders for use with both MSW 5.1 and MSW 6.x have
been included, each with pertinent documentation.

Differences between v 1.2.1 and 1.2

The principal change in this version was the addition of the "hidden text" in the stationery files.
Version  1.2.1  also  contained  some  significant  fixes  regarding  bugs  in  error-detection  that
managed to slip by in v 1.2!

                    
Differences between v 1.2 and 1.1

This  version was the  first  "fat"  binary  version,  containing  both  Macintosh  68K (68020 and
above) and native PowerPC code. The code for both types of processor was optimized to run
more quickly and efficiently than in previous versions. Improved error-detection for typing errors
in the  entry of  data  not  present  in  earlier  versions  was included in  v 1.2.  Additional  word-
processing template files for matrix layout were provided. The option of selecting either intra-
hexachordal or entire-set rotation for full twelve-tone sets was also added (v 1.1 allowed only
intra-hexachordal rotation). The other principal difference was a fix of a minor but potentially
annoying  bug involving creator types.

Differences between v 1.1 and 1.0

The differences between v 1.1  and v 1.0 were minimal. The code was optimized somewhat, and
it became unnecessary to adjust the column width in the Microsoft Word text-to-table conversion
prior to pasting the table onto the appropriate stationery file. 

This application is freeware, with no strings attached except that the application and related files
may not be sold or otherwise commercially exploited (though it  may, of course,  be used by
composers and/or analysts—after all, that's why it was written!).  For information, comments,
etc., e-mail me at "j-melby@uiuc.edu" or "JBMelby@aol.com". Enjoy!

John Melby
Professor of Music
University of Illinois at Urbana-Champaign
January 20, 1996
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